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1 Introduction

NetSim satellite library models end-to-end, full stack, packet level communication between terrestrial
nodes and Geostationary satellites. Geo satellites have the unique property of remaining permanently
fixed in exactly the same position in the sky as viewed from any fixed location on Earth. This means
ground-based antennas do not need to track them but can remain fixed in one direction. These satellites
have an orbital period that is the same as Earth’s rotation period and are the most common type of
communications satellites.

The Satellite MAC layer protocol supported in NetSim is TDMA for forward link and MF-TDMA for
return link (based on the DVB S2 standards). The forward link is in the Ku band (12 – 18 GHz) while
the return link is in the Ka band (26 – 40 GHz).

The satellite can be thought of as a relay station. It operates on the bent-pipe (transparent star) principle,
sending back to Earth what comes in, with only amplification and a shift from uplink to downlink
frequency.

In NetSim, the satellite communication network library interfaces with Internetworks library. This means
users can connect Satellite gateway and User Terminals to devices such as Routers, Switches Wired nodes,
Access point and Wireless nodes etc.

Figure 1-1: NetSim GUI showing Satellite User Terminals connected to a server via satellite links.

Figure 1-2: The Result dashboard and Plot window shown in NetSim after completion of simulation.

The PHY layer models include:

� Channel model: Friis free space path loss with Markov Loo fading model.
� Modulation: QPSK, 8PSK, 16APSK, 16QAM, 32APSK with appropriate coding rates.
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� Rx Antenna gains.
� Antenna gain to noise temperature.

All the choices of transport protocols, and all types of applications in unicast mode can be run.

NetSim’s protocol source C code shipped along with (standard / pro versions) is modular and customizable
to help researchers to design and test their own sat-com protocols.

2 Simulation GUI

Open NetSim, Go to New Simulation → Satellite Comm. Networks

Figure 2-1: NetSim Home Screen.

2.1 Create Scenario

Satellite Communication Networks palette features various devices like Wired Nodes, L2 Switch, Access
Point, Wireless node, UT Router (User Terminal Router), Router, UT Node (User Terminal Node),
Satellite Gateway, and Satellite.

2.2 Devices specific to NetSim Satellite Comm. Library

� UT - User Terminal. The user terminals are part of the same communication network as the
Satellite Gateway. The User Terminals in NetSim are UT Node and UT Router

� UT Router - User Terminal Router. A UT Router is used when a separate communication network
is required. The typical use case is where there are multiple devices downstream who seek to utilize
the sat-com link. The UT Router cannot be a source of any traffic.

� Satellite Gateway: Each gateway has two interfaces, a satellite interface and multiple wired
interfaces. The satellite interface connects via the forward link to the satellite. The wired interface
allows for connection to routers via the wired interface. When connected to a satellite, the user
terminals mapped to the gateway are part of the same network. Multiple gateways can be configured
per satellite, and round-robin scheduling is run (at the Network control center (NCC) which is not
displayed in NetSim GUI)

� Satellite: Since the satellite model is a bent pipe, the satellite does not have an IP. NetSim supports
single satellite communication, and it can be connected to multiple gateways and to multiple user
terminals. The satellite node cannot be the source of any traffic. The default altitude of the
Satellite is 35,768,000 meters, which represents the circular geosynchronous orbit.
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� Coordinate System: NetSim uses a Geodetic co-ordinate system. The altitude is from Mean Sea
level. The geocentric co-ordinate system uses distance from the centre of the earth.

Figure 2-2: The devices present in the ribbon in NetSim’s GUI.

2.3 Placement of devices on the grid environment

� Add a User Terminal (UT) – Click the User Terminal > UT Node icon on the toolbar and place
the device in the grid. UT Node must be connected to Satellite.

� Add a UT Router – Click the User Terminal > UT Router icon on the toolbar and place the device
in the grid. UT Router must be connected to a Node or to an L2 Switch or to a Router or to an
Access Point or Satellite.

� Add a Satellite – Click the Satellite icon on the toolbar and place the Satellite in the grid. Satellite
must be connected to a Satellite Gateway or to a UT Node or to a UT Router.

� Add a Satellite Gateway – Click the Satellite Gateway icon on the toolbar and place the Satellite
Gateway in the grid. Satellite Gateway must be connected to a Satellite or to a Router.

� Add a Router – Click the Router icon on the toolbar and place the Router in the grid.
� Add a Wired Node – Click the Wired Node icon on the toolbar and place the device in the grid.
� Add an L2 Switch – Click the L2 Switch icon on the toolbar and place the device in the grid.
� Add an Access Point – Click the Access Point icon on the toolbar and place the Access Point in

the grid.
� Add a Wireless Node – Click the Wireless Node icon on the toolbar and place the device in the

grid.

2.4 Enable Packet Trace, Event Trace (Optional)

Click Packet Trace / Event Trace icon in the Configure Reports option and check Enable Packet Trace /
Event Trace check box. For detailed help about the packet and event trace, please refer to sections 8.4
and 8.5 in the User Manual.

Figure 2-3: Enable Packet Trace, Event Trace & Plots options on top ribbon.

2.5 Enable protocol specific logs and plots

NetSim provides protocol-specific logs for Satellite libraries, which users can enable before running a
simulation. These can be enabled by clicking on configure reports in top ribbon > clicking on plots >
choosing as desired, and running the simulation.
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Figure 2-4: Enabling the Network logs in Satellite network.

Similarly, users can enable the plots for Satellite Radio Measurements.

Figure 2-5: Enabling the Plots in Satellite.

2.6 GUI Configuration Parameters

The SATELLITE parameters can be accessed by right clicking on a Satellite, Satellite Gateway, UT
Router or UT and selecting Interface (SATELLITE) Properties → Datalink and Physical Layers.
Table 2-1: Satellite, Satellite Gateway, UT Router or UT and selecting Interface (SATELLITE)
Properties – Physical Layers Description.

Parameter Type Range Description

Satellite Properties

Interface (Satellite) – Physical Layer

Continued on next page
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Table 2-1 continued from previous page

Parameter Type Range Description

Link Model Local Satellite Link,
Abstract Link

The Satellite Link implements a detailed
physical layer model that captures RF
propagation characteristics such as
free-space pathloss, antenna gain, EIRP,
additional losses, noise figure, interference
(CIR), exact geometric and
SNR/SINR-based adaptive and fixed
modulation and coding.

The Abstract Link represents an idealized
communication channel model
implemented under the Physical Layer.

Noise Figure (dB) Local 1–12 Represents the receiver’s internal noise
contribution. A lower noise figure indicates
that the receiver is more sensitive and
capable of detecting weaker signals.

Carrier to
Interference Ratio
(dB)

Local −20 to +20 Measures the strength of the desired signal
compared to the interference power in the
channel.

Exact Geometric
Interference (dB)

Local Geometric interference arises when
multiple beams sharing the same channel
ID overlap, leading to co-channel
interference at user terminals.

Antenna aperture
Radius (m)

Local 0.1 – 5 This parameter defines the antenna’s
aperture radius. Used for antenna gain
calculations.

Frequency reuse
factor

Local FR1, FR2, FR3, FR4 Represents the number of channels
allocated per beam configuration. FR1
indicates full frequency reuse across all
beams, while FR3 reduces inter-beam
interference by using three distinct
frequency groups.

Beam radius (km) Local Based on band it
varies

The beam radius is calculated based on
the frequency band, satellite altitude, and
antenna aperture radius for the selected
scenario. It is defined at the point where
the beam power drops to half of its
maximum value (3 dB beamwidth).

Beam count Local 1, 7, 19 This parameter defines the number of
beams formed in the coverage area. A
value of 1 corresponds to a single central
beam. The 7-beam configuration consists
of one central beam surrounded by a single
hexagonal ring, while the 19-beam
configuration consists of the central beam
with two hexagonal layers of surrounding
beams.

Continued on next page
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Table 2-1 continued from previous page

Parameter Type Range Description

G/T (dBK) Local Manual Antenna gain-to-noise-temperature (G/T)
where G is the antenna gain in decibels at
the receive frequency, and T is the
equivalent noise temperature of the
receiving system in kelvins.

G/T (dBK) Auto Computed using the noise figure and the
RX gain

Antenna model Local TR 38.811 S.6.4.1,
ITU-R S.672-4

TR 38.811 S.6.4.1: The normalized
antenna gain pattern, corresponding to a
typical reflector antenna with a circular
aperture, is considered.

ITU-R S.672-4: To model the off-axis
behavior of satellite antennas, the ITU-R
S.672 recommendation specifies that, for
single-feed circular or elliptical beam
spacecraft antennas operating in the
fixed-satellite service (FSS).

LN Value (dB) Local −25, −20 LN is near-in-side-lobe level in dB relative
to the peak gain required by the system
design.

LF Value (dB) Local −100 to 10 LF represents the minimum gain level (in
dB) beyond which the antenna pattern
does not decrease further.

a, b, α Local Values are updated based on the LN
selection as per ITU-R specification.

z Local 1 (major axis/minor axis) for the radiated
beam.

LB (dB) Local LB = 15 + LN +
0.25Gm + 5 log z dBi
or 0 dBi whichever is
higher.

LB is the back lobe gain level used in the
antenna pattern

Theta HPBW (◦) Local 1–10 One-half the 3 dB beamwidth in the plane
of interest (3 dB below Gm) (degrees)

Access Protocol Fixed TDMA TDMA allows a number of clients to access
a single radio-frequency channel without
interference by allocating unique time slots
to each user within each channel, reducing
the loss of packets and improving the data
rate thereby delivering QoS to the clients.

Access Protocol Fixed MF-TDMA Multi-frequency time-division multiple
access is a technology for dynamically
sharing bandwidth resources in an
over-the-air two-way communications
network.

Base Frequency
(GHz)

Local Ku-band: 12–18 GHz,
Ka-band: 26–40 GHz

The “band” in use refers to the radio
frequencies used to and from the satellite.
Ku-band services use the 12–18 GHz, and
Ka-band services use the 26–40 GHz
segment of the electromagnetic spectrum.

Continued on next page
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Table 2-1 continued from previous page

Parameter Type Range Description

Band Fixed KU Microwave frequency band used for
satellite communication and broadcasting,
using frequencies in the range of
12–18 GHz

Band Fixed KA Microwave frequency band used for
satellite communication and broadcasting,
using frequencies in the range of
26–40 GHz

Rolloff Factor Local 0–1 In NetSim, Symbol Rate = BW / (1+Roll
off factor) and Bit Rate = Symbol rate ×
Modulation order × CodeRate

Spacing Factor Local 0–1 In NetSim EffectiveBandwidth (Hz) =
AllocatedBandwidth (Hz) /
((RollOffFactor + 1.0) × (SpacingFactor +
1.0)); Spacing factor should be in the
range of [0,1]

Carrier Bandwidth
(Hz)

Local 0–1000000 Hz Bandwidth of the carrier in Hz

Frame count in
Superframe

Local 0–1000000 Number of frames present in a superframe.

MCS Selection Local Fixed MCS, Adaptive
MCS

Fixed MCS: The modulation and coding
rate remain constant throughout the
simulation. Adaptive MCS mode: The
physical layer dynamically adjusts the
modulation and coding rate based on the
Signal-to-Noise Ratio (SNR) calculated
from the link-budget model.

MCS Index table Local Index, Modulation,
Coding rate, Spectral
efficiency

The MCS Index Table defines the mapping
between modulation and coding schemes
used for data transmission.

Frame Usage Mode Local NORMAL, SHORT Baseband frame usage modes.

Modulation Local QPSK, 8PSK,
16APSK, 16QAM,
32APSK

Modulation is the process of varying one
waveform in relation to another waveform.
It is used to transfer data over an analog
channel.

Coding Rate Local 1/3, 1/2, 3/5, 2/3, 3/4,
4/5, 5/6, 8/9, 9/10

It states what portion of the total amount
of information that is useful
(non-redundant). This code rate is
typically a fractional number.

BER Model Local Fixed BER value is based on the user input and
is independent of the received SINR.

BER Model Local FILE BASED File Based is a feature in NetSim with
which users can define the BER. Users will
have to provide a BER FILE.txt file as
input to NetSim by clicking on the Open
file link the Physical Layer-Properties of
the device.

BER Model Local MODEL BASED BER is computed using the SINR-BER
formula for the chosen Modulation and
coding. The pathloss and fading models
are used in the SINR calculation.

Continued on next page
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Table 2-1 continued from previous page

Parameter Type Range Description

BER Local 0.00000001–1 This parameter is shown if the Fixed
option is chosen for the BER model
parameter. Users can set the Bit Error
Rate (BER) in the range shown.

Additional loss
(dB)

Local −20 to +20 Represents attenuation in the signal path
due to imperfections

EIRP Density
(dBW/MHz)

Local 35–70 This parameter defines the effective
isotropic radiated power per unit
bandwidth.

Link speed (Mbps) Local 1–100 Defines the constant data rate available on
the link and is used to compute the packet
transmission time.

Propagation delay
(ms)

Local Auto computed, Fixed
(1–100)

Auto computed: Calculated automatically
based on device distance and the speed of
light. Fixed: A constant delay value
entered by the user.

UT Properties

Interface (Satellite) – Physical Layer

Rx Antenna Gain
(dB)

Local 0–1000000 dB A relative measure of an antenna’s ability
to receive radio frequency energy in a
particular direction or pattern at the
receiver side.

Table 2-2: Propagation Model/Wireless Link Properties Description.

Parameter Type Range Description

Propagation Model

Link Properties

Propagation Medium Link Air Medium of propagation in NetSim would
be Air for RF waves.

Channel
Characteristics

Fixed Pathloss and
Fading and
Shadowing

Path loss and fading and shadowing: In
pathloss models, for a fixed distance
between source and destination, path loss
is the same. We get varied path loss for
the same distance between source and
destination in shadowing, and fading is the
variation of the attenuation of a signal
with various variables. These variables
include time, geographical position, and
radio frequency.

Shadowing Model Fixed NONE

Pathloss Model Link Friis Free Space Used to model the LOS path loss incurred
in the channel. The Friis Free space model
is restricted to unobstructed clear path
between the transmitter and the receiver.

Pathloss Exponent (η) Fixed 2 Path loss exponent indicates the rate at
which the path loss increases with distance.
The value depends on the specific
propagation environment.

Continued on next page
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Table 2-2 continued from previous page

Parameter Type Range Description

Fading Model Fixed Markov Loo Each state of the three-state Markov
channel models obeys the Loo distribution
with different parameters; while the state
transition is modeled as a first-order
Markov random process.

Direct Signal Mean
(dB)

Link −∞ to ∞ Mean value of the direct signal, value can
be differentiated according to the state.

Direct Signal Standard
Dev (dB)

Link 0 to ∞ Standard Deviation of the direct signal
value can be differentiated according to
the state.

RMS Multipath Power
(dB)

Link −∞ to ∞ RMS squared multipath power in dB

Number of Direct
Signal Oscillators

Link 0 to ∞ Number of direct signal oscillators is used
for frequency conversion process in
superheterodyne receiver.

Number of Multipath
Oscillators

Link 0 to ∞ Number of multipath oscillators is used to
generate higher oscillation frequencies.

Direct Signal Doppler
(Hz)

Link 0 to ∞

Multipath Doppler
(Hz)

Link 0 to ∞ The normalized PSD (its integral in the
whole frequency range equals to one)
constitutes the PDF for the Doppler
frequencies, arising from the different
angles of arrival the multipath components
have with respect to the receiver’s motion.

Initial Probability Link 0 to 1 An initial probability distribution, defined
on S, specifies the starting state. Usually
this is done by specifying a particular state
as the starting state.

2.6.1 Mapping of User Terminal (UT Node / UT Router) to Satellite Gateway

Each satellite can be connected to multiple Satellite Gateways and to Multiple User Terminals. The
following screen shot shows how to map the User Terminal to Satellite Gateway as shown in Figure 2-6.
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Figure 2-6: Mapping of User Terminal (UT Node / UT Router) to Satellite Gateway.

In order to Map User Terminal (UT Node / UT Router) to Satellite Gateway right click go to the
properties of UT Node/UT Router → INTERFACE1 (SATELLITE) → DATALINK LAYER → Gateway
user can map the Satellite Gateway with UT Node / UT Router accordingly.

Additionally, in the UT Router/UT Node → Interface Satellite the default gateway IP should be set as
the IP of the connected Satellite Gateway.

Incorrect mapping of the Satellite Gateway and/or the default Gateway IP address, in the properties of
the UT Node / UT Router could lead to application crash or NIL application throughputs.

2.6.2 Configuring Static Routes

After mapping the UT Router/UT Node to a Satellite Gateway, static routes need to be configured in
the devices to forward traffic. Let us consider the following network scenario as shown in Figure 2-7.
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Figure 2-7: Network Topology in this experiment.

In this network scenario, for UDP traffic to be sent from UT Node 3 to UT Node 4, static routes need to
be set in UT Node 3 and in the Satellite Gateway 2.

If TCP traffic needs to be sent from UT Node 3 to UT Node 4, then static routes need to be set in UT
Node 4 as well. This is essential for connection establishment and sending acknowledgements.

Refer to the featured example on Configuring applications from UT Node to UT Node for detailed
information on static route configuration.

2.6.3 Mobility model in Satellite

Satellite and UT devices support file-based mobility in Satellite.

In the File Based Mobility model, users can write their own custom mobility models and define the
movement of the mobile users. The content should be per the NetSim Mobility File Format explained
below. Users can also generate the mobility files using external tools like SUMO (Simulation of Urban
Mobility), etc.

The NetSim Mobility File setting and format is explained below:

Step 1: Right click to open Properties as a new window of Satellite or UT. Then properties > Position
Properties > Mobility model as File Based Mobility and click on Open Mobility file.

Step 2: Open the csv file and write the node mobility in the format shown below.

<TIME IN SECONDS>,<DEVICE ID>Lat(°),Lon(°),Alt(m)
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Figure 2-8: Mobility.csv file with inputs added via MS Excel.

3 Model Features

Under the Physical Layer, two types of links are modeled in the Satellite communication system.

� Abstract Link
� Satellite Link

3.1 Abstract Link Model

The Abstract Link represents an idealized communication channel model implemented under the Physical
Layer. It applies to both the Forward and Return directions. Unlike the Satellite Link, with Abstract
Link NetSim does not perform link-budget or radio-frequency calculations.

Configurable Parameters

The Abstract Link behaviour is characterized by a small set of user-specified parameters that determine
the resulting throughput, delay, etc.

Link Speed (Mbps)

Defines the constant data rate available on the link and is used to compute the packet transmission time.

Bit Error Rate (BER)

Represents the probability of bit errors occurring during transmission over the communication link.

Propagation Delay (ms)

Represents the signal propagation delay, which can be either:

� Auto Computed: Calculated automatically based on device distance and the speed of light.
� Fixed: A constant delay value entered by the user.

3.2 Satellite Link Model

The Satellite Link implements a detailed physical layer model that captures RF propagation characteristics
such as free-space pathloss, antenna gain, EIRP, additional losses, noise figure, interference (CIR), and
SNR/SINR-based adaptive and fixed modulation and coding.
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With this model NetSim performs link-budget-based calculations to determine received signal strength and
signal quality parameters such as SNR, and SINR. In the current implementation, SNR-based link-budget
computation is applied only for the service links (User-terminal (UT) ↔ Satellite).

� UT → Satellite (Uplink)
� Satellite → UT (Downlink)

For the feeder links (i.e., Gateway ↔ Satellite), SNR calculation is not applied. These links operate using
the same link-speed and propagation delay values, computed for the service link.

3.3 TDMA Forward Link and MF TDMA Return Link

Figure 3-1: Forward and Return links. The Network Control Centre (NCC) is not displayed in NetSim
and is assumed to be part of every satellite.

In NetSim, a Forward link is defined as the direction from Satellite Gateway to Satellite to UT Node /
UT Router. A Return link is defined as the direction from the UT Node / UT Router to Satellite to the
Satellite Gateway.

The protocol operating in the Forward link is Time Division Multiple Access (TDMA). The protocol
operating in the Return link is Multi Frequency Time Division Multiple Access (MF-TDMA).

Both the Forward link and Return link transmissions in NetSim are modeled as Layer-2 transmissions.
The framing is as explained in the subsequent paragraph.

Each Super Frame is composed of a number of Frames. This is taken as a user input, given by the attribute
Frame count in Superframe available in Satellite → Interface Satellite → Physical Layer properties.

3.4 Downlink MAC Scheduling

� The satellite MAC implements a beam-based, event-driven TDMA scheduling mechanism with
adaptive modulation and coding (AMC).

� Scheduling decisions are made dynamically at run time, and transmission timing is driven by frame
completion events, not by fixed time boundaries.

� Each beam operates as an independent scheduler, allowing parallel transmissions without global
synchronization.

Beam Formation

Each UT is associated with a beam; this selection is based on maximum SINR.

Each beam maintains its list of UTs.

Beam-wise Scheduling
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Each beam operates as an independent TDMA scheduler.

Frame transmissions occur independently at each beam.

Scheduling decisions within one beam do not affect other beams.

Frame Allocation and Round Robin Scheduling

� Each transmitted frame is assigned to exactly one UT.
� Frame assignment follows a round-robin (RR) policy within the beam.
� The round-robin state is maintained per beam, not globally.

Scheduling Flow (Per Beam)

� A frame is scheduled for a UT.
� The frame is transmitted.
� At frame completion, the next frame for the same beam is immediately scheduled.
� The next UT is selected using round-robin rotation.
� This creates a continuous transmission chain per beam.

Packet Packing within Frames:

Once a frame is assigned to a UT buffer, packets are packed into the frame.

Packing Rules

Packets are packed sequentially from the buffer head (FIFO).

Packet size is evaluated in bits.

A packet is included only if it fully fits within the remaining frame capacity.

Partial packet transmission is not supported.

Packing stops when:

The next packet exceeds the remaining frame capacity.

The buffer becomes empty.

At the end of packing, the frame contains only the packets that fully fit within its capacity.

Frame Length and Payload Capacity Computation

� The total frame size is fixed as per DVB-S2 specifications

Frame Bits = 64800

� Symbol rate is the effective bandwidth that we set in the GUI
� Based on the selected modulation and coding
� Number of Symbols per Frame

SymbolsPerFrame = Frame Bits/Mod Bits

� Frame Duration

FrameDuration = (SymbolsPerFrame/SymbolRate)

� Usable Payload Capacity

PayloadBits = Frame Bits × CodingRate

Impact of SINR (Adaptive MCS)

Higher SINR results in the selection of higher-order modulation and coding schemes. This leads to:

Shorter frame duration

Higher payload capacity
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Lower SINR results in longer frame durations and reduced payload capacity.

Frame duration directly influences superframe timing.

NOTE: Uplink scheduling is not implemented currently.

3.5 Modulation and coding (MODCOD) schemes selection

The Modulation and Coding Scheme (MCS) determines the combination of modulation order and coding
rate used in the physical layer for both the Forward and Return links.

NetSim supports two MCS configuration modes: Fixed MCS and Adaptive MCS.

Fixed MCS Mode

� In Fixed MCS mode, the modulation and coding rate remain constant throughout the simulation.
� The user selects the desired modulation type (e.g., QPSK, 8PSK, 16APSK, etc.) and coding rate

from the GUI.
� The selected MCS values are applied to all devices, irrespective of variations in the channel or SNR

conditions.

Modulation and coding schemes supported:

1. QPSK with coding rates 1/3, 1/2, 1/4, 2/5, 3/5, 2/3, 3/4, 4/5, 5/6, 8/9, 9/10
2. 8PSK with coding rates 3/5, 2/3, 3/4, 5/6, 8/9, 9/10
3. 16APSK with coding rates 2/3, 3/4, 4/5, 5/6, 8/9, 9/10
4. 16QAM with coding rates 3/4, 5/6
5. 32APSK with coding rates 3/4, 4/5, 5/6, 8/9, 9/10
6. These modulation and coding rates are specified in Table 12 on page 32 of the ETSI EN 302 307 –

European Standard.

Adaptive MCS Mode In Adaptive MCS mode, the physical layer dynamically adjusts the mod-
ulation and coding rate based on the Signal-to-Noise Ratio (SNR) calculated from the link-budget
model.

MCS Configuration files

� NetSim uses external configuration files to define the mapping between SNR and the corresponding
Modulation and Coding Scheme (MCS).

� Separate CSV files are used for the Forward and Return links:
� ForwardLink Modulation.csv
� ReturnLink Modulation.csv
� The format of the CSV files is as shown below:
� Index, Modulation, Coding Rate and Spectral Efficiency

Modulation CodingRate SpectralEfficiency

Forward link Spectral efficiency values

QPSK 0.333333 0.56

QPSK 0.5 0.87

QPSK 0.666667 1.26

QPSK 0.75 1.42

QPSK 0.833333 1.6

8PSK 0.666667 1.7

8PSK 0.75 1.93

8PSK 0.833333 2.13

Continued on next page

Copyright TETCOS LLP Page 18 of 46



NetSim – Satellite Communication Ver 15.0

Continued from previous page

Modulation CodingRate SpectralEfficiency

16QAM 0.75 2.59

16QAM 0.833333 2.87

Return link Spectral efficiency values

QPSK 0.25 0.490243

QPSK 0.333333 0.656448

QPSK 0.4 0.789412

QPSK 0.5 0.988858

QPSK 0.6 1.188304

QPSK 0.666667 1.322253

QPSK 0.75 1.487473

QPSK 0.8 1.587196

QPSK 0.833333 1.654663

QPSK 0.888889 1.766451

8PSK 0.6 1.779991

QPSK 0.9 1.788612

8PSK 0.666667 1.980636

8PSK 0.75 2.228124

8PSK 0.833333 2.478562

16APSK 0.666667 2.637201

8PSK 0.888889 2.646012

8PSK 0.9 2.679207

16APSK 0.75 2.966728

16APSK 0.8 3.165623

16APSK 0.833333 3.300184

16APSK 0.888889 3.523143

16APSK 0.9 3.567342

32APSK 0.75 3.703295

32APSK 0.8 3.951571

32APSK 0.833333 4.11954

32APSK 0.888889 4.397854

32APSK 0.9 4.453027

Figure 3-2: The default spectral efficiency to MCS mapping when the adaptive MCS option is chosen

Adaptive MCS Selection Logic

� Obtain the Signal-to-Interference-Noise Ratio (SINR).
� Convert SNR from dB to Linear Scale.

SINRLinear = 10

(
SINRdB

10

)
(1)

� Compute Spectral Efficiency (SE)

Spectral Efficiency = log2(1 + SINRLinear) (2)

� Select the Appropriate MCS files based on the link direction.
� The selected CSV file defines how spectral efficiency maps to the corresponding modulation and

coding rate.
� The entry with the largest spectral-efficiency threshold that is less than or equal to the computed
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SE is chosen.
� This Adaptive MCS mechanism enables dynamic adjustment of modulation and coding according

to real-time channel conditions.
� As the SNR increases, higher-order modulation and coding rates are selected to enhance spectral

efficiency and throughput.

The modulation, coding rate and spectral efficiency values used in NetSim’s Adaptive MCS configuration
are derived from the OpenSAND MODCOD database (https://github.com/CNES/opensand/wiki/acm).

3.6 Physical layer framing for forward and return links

Figure 3-2: Format of a “Physical Layer Frame” PLFRAME.

Default settings in NetSim

� Frame Type: Normal (Options are normal or short)

3.7 Satellite PHY

Given below is the data rate calculation methodology for both forward and return links. The parameter
values used are the default values in NetSim GUI.

Symbol Rate =
BW

(1 + (Roll off factor))
(3)

Bit Rate = Symbol rate×Modulation order× CodeRate (4)

Bandwidth (Hz) = Frame Bandwidth (Hz) = 106 Hz

Central Frequency (Hz) = Base Frequency (Hz) +
Bandwidth (Hz)

2.0

Central Frequency (Hz) = 26× 109 +
106

2
= 2.60005× 1010 Hz

Effective Bandwidth (Hz) =
Carrier Bandwidth (Hz)

(RollOffFactor + 1.0)× (SpacingFactor + 1.0)
(5)
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Effective Bandwidth (Hz) =
106

(1.0 + 1.0)× (1.0 + 1.0)
= 25× 104 Hz

Symbol Rate = Effective Bandwidth (Hz) = 25× 104 Hz

Modulation Bits = 2

The number of Modulation Bits depends on the modulation scheme per the table below:

Table 3-2: Modulation bits for different modulations.

Modulation Modulation bits

QPSK 2

8PSK 3

16APSK/16QAM 4

32APSK 5

3.8 Satellite PHY: Land Satellite Channel Model

3.8.1 Propagation

The distance between the ground nodes and the satellite determines the propagation delay and path loss
of the radio signal. The distance is computed based on the cartesian distance between the ground nodes
and the satellite. NetSim computes the propagation delay of the radio signal traveling from the source
node to the destination node at the speed of light. The propagation model calculates the weakening of
the radio signal as it propagates from the source node per the pathloss and fading model.

3.8.2 Earth fixed spot beams and cells

NetSim provides three methods for configuring satellite beams:

Standard setup:

The Standard Setup option allows users to quickly configure satellite beams using predefined parameters
without manually entering beam coordinates or importing external files. NetSim automatically calculates
the beam geometry, radius, and coverage area based on the selected inputs.

� Number of spot beams.
� NetSim can presently support configurations of 1, 7, or 19 spot beams.
� The 7-cell setup consists of a central hexagonal cell surrounded by 6 adjacent cells.
� The 19-cell configuration has two layers of surrounding cells around a central hexagonal cell.
� NetSim will automatically compute the tessellated beams (cells) based on number of spot beams.

User-defined beam configuration:

This option allows users to upload an Excel/CSV file containing beam parameters such as beam count,
Frequency reuse, Satellite altitude (km), HPBW (theta), Aperture radius (m), Band, Beam centers,
Antenna model and Beam radius (km) details instead of relying on automatic or standard setup.
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Figure 3-3: User-defined beam configuration.

Manual Placement:

The Manual Placement option allows complete user control over beam locations, coverage regions, and
satellite altitude. Unlike the Standard Setup or CSV Upload options, no beam parameters are auto-
generated. This mode is intended for advanced users who want full flexibility in defining exact beam
geometry.

3.8.3 Link budget calculations

UT is sending to Satellite:

The carrier-to-noise ratio, CNR in dB, is calculated per the equation described in TR 38.821 Section
6.1.3.1, given by

CNR = EIRP −MaxAntennaGain + AngularGain +Rx
G

T
− k − PLFS − PLAD −B (6)

where:

CNR is the carrier to noise ratio (also sometimes termed as SNR or signal to noise ratio) in dB

EIRP is the effective isotropic radiated power in dBW

RxG
T is the antenna-gain-to-noise temperature in dB/K of the receiver

k is the Boltzmann constant with the value of −228.6 dBW/K/Hz

PLFS is the free space path loss (FSPL) in dB

PLAD is the additional loss in dB

B is the channel bandwidth in dBHz (i.e., 10 log10(BW ), where BW is bandwidth in Hz)

RxG
T is obtained using the expression

Rx
G

T
= Grx −Nf − 10 log10

(
T0 + (Ta − T0)× 10−0.1×Nf

)
(7)
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where:

Grx is the receive antenna gain in dBi.

Nf is the noise figure in dB

T0 is the ambient temperature in degrees Kelvin, set to 290 by default

Ta is the antenna temperature in degrees Kelvin. Ta = 150

The CNR expression is used in both directions i.e., terrestrial to satellite and satellite to terrestrial.

Satellite is sending to the UT:

CNR = EIRP −MaxAntennaGain + AngularGain + UTRx Gain− k − PLFS − PLAD −B (8)

Elevation angle:

α = sin−1

(
D

Ru · L

)
(9)

Where,
Ru =

√
x2ue + y2ue + z2ue (10)

L =
√
(xsat − xue)2 + (ysat − yue)2 + (zsat − zue)2 (11)

D =
√
(xsat − xue) · xue + (ysat − yue) · yue + (zsat − zue) · zue (12)

EIRP calculations:

In NetSim’s satellite model, the method of computing EIRP depends on the link direction:

Forward Link

� In the Forward Link, the satellite transmits toward the user terminal (UT).
� The EIRP is defined based on the EIRP Density and the allocated bandwidth of the carrier

EIRP [dBW] = EIRPDensity [dBW/MHz] + 10 log10(BW [MHz]) (13)

Return link

� In the Return Link, the user terminal (UT) transmits toward the satellite.
� The EIRP is computed from the transmit power and the Receive antenna gain of the UT.

EIRP [dBW] = Ptx [dBm]− 30 +GRx [dBi] (14)

SNR - BER Calculation The Signal-to-Noise Ratio (SNR) is calculated separately for each hop of
every link.

SNR-based Bit Error Rate (BER) computation is applied only for the UT–Satellite and Satellite–UT
links.

NetSim provides three options for BER.

� Model Based: The BER is then calculated for each link based on the SNR. Please see Propagation-
Models.pdf document for detailed information on BER calculation.

� Fixed: the BER value can be input in the GUI. If this option is chosen, the SNR (derived from
propagation model) is not used.
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� File Based: SNR – BER table should be provided in a file per the format given below. This table
should be in increasing order of SNR. The SNR is calculated by NetSim from the RF propagation
model. For this SNR, the appropriate BER is selected from this table. BER is 1.0 for any SNR
value below SNR1, and BER is 0.0 for any SNR greater than SNRn.

SNR1, BER1

SNR2, BER2

...

SNRn, BERn

NOTE: Users can enable the Satellite Propagation Log to see the SNR calculated from RF propagation
model and then choose appropriate entries of SNR, BER values into the BER-File to see the impact on
throughput.

3.8.4 Pathloss Model – Friis Free Space Propagation

The free space propagation model is used to predict received signal strength when the transmitter and
receiver have a clear, unobstructed line-of-sight path between them. Satellite communication systems and
microwave line-of-sight radio links typically undergo free space propagation. The mathematical expression
for free-space path loss is given by the Friis Free-Space Equation:

PLFS = 20 log10

(
4πd

λ

)
(15)

Where λ = c
f ,

d is the slant height in meters,

λ is the wavelength in meters.

3.8.5 Fading model

NetSim uses a 3-state (state 1, state 2 and state 3) Markov model to simulate fading.

The conditional probabilities of state sn+1 given the state sn are described by state transition probabilities
pij

Where S1, S2, S3 denote respective channel states, Pij is the probability the Markov process goes from
state i to state j.

Figure 3-4: Switching of three-state Markov process.

The switching among each state is described by a transition matrix P, which is
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P =

p11 p12 p13
p21 p22 p23
p31 p32 p33

 (16)

Each state of the three states of the Markov model obeys the Loo distribution with different parameters,
while the state transition is modeled as a first-order Markov random process.

The Loo distribution considers the received signal as a sum of two signal components. A log-normally
distributed direct signal expresses the slow fading component corresponding to varying shadowing
conditions of the direct signal. A Rice distribution characterizes the fast-fading component due to
multipath effects.

The Loo parameter triplet consists of the mean, the standard deviation for the log-normally distributed
direct signal, and the average multipath power.

N(µ, σ2) +R (17)

Depending on the current state interval and on the environment of the terminal, a new random Loo
parameter triplet is generated. The output of the channel model is a time-series of the received signal in
the form of a complex envelope.

And finally, the model computes the Loo distributed time-series including Doppler shaping for every new
state interval, which is the output of the proposed LMS channel model.

Figure 3-5: The Satellite LMS channel Model.

3.8.6 Antenna Models

TR 38.811 Antenna model The normalized antenna gain pattern, corresponding to a typical
reflector antenna with a circular aperture, is considered

G(θ) =


1 for θ = 0

4

∣∣∣∣J1(ka sin θ)ka sin θ

∣∣∣∣2 for 0 < |θ| ≤ 90◦
(18)

where J1(x) is the Bessel function of the first kind and first order with argument x, a is the radius of the
antenna’s circular aperture, k = 2πf

c is the wave number, f is the frequency of operation, c is the speed

Copyright TETCOS LLP Page 25 of 46



NetSim – Satellite Communication Ver 15.0

of light in a vacuum and θ is the angle measured from the boresight of the antenna’s main beam. Note
that ka equals the number of wavelengths on the circumference of the aperture and is independent of the
operating frequency. The above expression provides the gain in linear scale and it needs to be converted
to dB scale. The normalized gain pattern for a = 10 c

f (aperture radius of 10 wavelengths) is shown below

Figure 3-6: Antenna gain pattern for aperture radius 10 wavelengths, a = 10 c
f .

ITU-R S.672 Antenna model To model the off-axis behavior of satellite antennas, the ITU-
R S.672 recommendation specifies that, for single-feed circular or elliptical beam spacecraft antennas
operating in the fixed-satellite service (FSS), the following radiation pattern should be used as the design
objective outside the coverage area.

G(ψ) = Gm − 3

(
ψ

ψb

)α

[dBi] for ψb ≤ ψ ≤ aψb (19)

G(ψ) = Gm + LN + 20 log(z) [dBi] for aψb < ψ ≤ 0.5bψb (20)

G(ψ) = Gm + LN [dBi] for 0.5bψb < ψ ≤ bψb (21)

G(ψ) = X − 25 logψ [dBi] for bψb < ψ ≤ Y (22)

G(ψ) = LF [dBi] for Y < ψ ≤ 90◦ (23)

G(ψ) = LB [dBi] for 90◦ < ψ ≤ 180◦ (24)

Where:
X = Gm + LN + 25 log(bψb) and Y = bψb · 100.04(Gm+LN−LF ) (25)

� G(ψ) : gain at the angle ψ from the main beam direction (dBi)
� Gm : maximum gain in the main lobe (dBi)
� ψb: one-half the 3 dB beamwidth in the plane of interest (3 dB below Gm) (degrees)
� LN : near-in-side-lobe level in dB relative to the peak gain required by the system design
� LF = 0 dBi: far side-lobe level (dBi)
� z: (major axis/minor axis) for the radiated beam
� LB: 15 + LN + 0.25Gm + 5 log z dBi or 0 dBi whichever is higher

LN (dB) a b α

−20 2.58 ·
√
(1− log(z)) 6.32 2

−25 2.58 ·
√
(1− 0.8 · log(z)) 6.32 2

Figure 3-8: LN selection to get a, b and α.
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The numeric values of a, b, and α for LN = −20 dB and −25 dB side-lobe levels are given in the above
table.

3.8.7 Off Boresight Angle Calculation

Conceptually, the off-boresight angle, θ, in the antenna gain formula is defined as the angle between
two vectors: one along the boresight of the beam (i.e., from the satellite to the beam centre, which
corresponds to the sub-satellite nadir point), and the other from the satellite to the UE. In NetSim, θ is
computed as the arccosine of the normalized dot product of these two vectors.

Standard ENU-Based Look Angle Computation (Satellite to Earth)

This section describes the standard ENU (East–North–Up) method for computing satellite look angles
(azimuth and elevation) as seen from an earth station (user terminal).

Notation

φt : Latitude of earth station (degrees)

λt : Longitude of earth station (degrees)

Ht : Altitude of earth station above sea level (km)

φs : Latitude of satellite (degrees)

λs : Longitude of satellite (degrees)

Hs : Altitude of satellite above sea level (km)

Step 1: Convert Geodetic Coordinates to ECEF

Convert both earth station and satellite geodetic coordinates to Earth-Centered Earth-Fixed (ECEF)
Cartesian coordinates.

� WGS-84 ellipsoid constants
� WGS-84 defines the Earth as an oblate ellipsoid with:
� Semi-major axis (equatorial radius):

a = 6378137.0 m

� Flattening:

f =
1

298.257223563

� First eccentricity squared:

e2 = 2f − f2

� Numerically:

e2 ≈ 0.00669437999014

� Prime vertical radius of curvature

N(ϕ) =
a√

1− e2 sin2(ϕ)

� This is to compensate for Earth’s flattening.
� ECEF Conversion formulas (WGS-84)

X = (N + h) cos(ϕ) cos(λ)
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Y = (N + h) cos(ϕ) sin(λ)

Z =
(
N(1− e2) + h

)
sin(ϕ)

This gives Earth-Centered Earth-Fixed (ECEF) coordinates:

� X axis: intersection of equator and Greenwich meridian
� Y axis: 90◦ east on equator
� Z axis: North pole

Step 2: Line-of-Sight Vector in ECEF

Compute the line-of-sight (LOS) vector from the earth station to the satellite:

∆r = rs − rt = (∆X,∆Y,∆Z)

Step 3: Rotate LOS Vector into Local ENU Frame

Define the standard ECEF-to-ENU rotation matrix at the earth station latitude φt and longitude λt:EN
U

 =

 − sin(λt) cos(λt) 0

− sin(ϕt) cos(λt) − sin(ϕt) sin(λt) cos(ϕt)

cos(ϕt) cos(λt) cos(ϕt) sin(λt) sin(ϕt)


∆X∆Y
∆Z

 (26)

This yields the local ENU components (E, N , U) of the satellite relative to the earth station.

Step 4: Slant Range

The straight-line distance between the earth station and the satellite is:

Dts =
√
E2 +N2 + U2 (27)

Step 5: Elevation Angle

The elevation angle (above the local horizontal plane) is computed as:

el = atan2
(
U,

√
E2 +N2

)
(28)

Elevation is in the range −90◦ to +90◦.

Step 6: Azimuth Angle

The azimuth angle, measured clockwise from true North, is:

az = atan2(E,N) (29)

The result should be wrapped to the range 0◦–360◦.

Step 7: Visibility Check

Given a minimum elevation mask angle (maskAngle):

visible = 1 if el ≥ maskAngle

visible = 0 otherwise

If
√
E2 +N2 ≈ 0 (satellite directly overhead), the azimuth is indeterminate.
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3.8.8 Frequency Reuse

NetSim supports FR1 (Nreuse = 1), FR2 (Nreuse = 2), FR3 (Nreuse = 3) and FR4 (Nreuse = 4)
configurations.

With NetSim GUI, users can configure the number of beams (1, 7, and 19) and select the frequency reuse
factor (FRF) accordingly. When Nreuse > 1, NetSim assigns virtual “channel IDs” to the beams. The
available resources and bandwidth are then equally divided among the channels. The bandwidth per
channel is calculated per the following expression

BWchannel =
BWTotal

Nchannels
(30)

3.8.9 Interference models

Exact Geometric Interference Geometric interference arises when multiple beams sharing the
same channel ID overlap, leading to co-channel interference at user terminals. The level of interference is
influenced by the number of beams and the configured frequency reuse factor. In FR1, interference occurs
from all available beams, whereas in FR2, FR3 and FR4 it is limited to beams using the same channel ID.

CIR-based Interference Per TR 38.821 section 6.1.3.1 the Carrier-to-noise-and-interference ratio
(CNIR) of the transmission link between satellite and UE can be derived by carrier-to-noise ratio (CNR)
and carrier-to-interference ratio (CIR) as follows

CNIR [dB] = −10 log10

(
10−0.1·CNR [dB] + 10−0.1·CIR [dB]

)
(31)

Carrier-to-Interference Ratio (CIR) is the user input and

CNR (dB) is computed from the link budget, based on EIRP, G/T, path loss and the antenna gain.

Interference power calculations for CIR based Interference

Interference [mW] = Noise [mW]×
(
CNR [mW]

CNIR [mW]
− 1

)
(32)

Interference [dB] = 10× log10(Interference [mW]) (33)

3.9 Results

Please refer to the NetSim User Manual, section 8, for Results and Analysis.

3.9.1 Satellite Log

NetSim Satellite Log file records UT Satellite association, calculated superframe, frame, slot, bandwidth,
etc. This log can be enabled/disabled by going to Plots option and checking/unchecking the Satellite Log
option under the Network Logs section as shown below:
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Figure 3-7: Enabling Satellite Log file.

A log file specific to satellite communication, is generated post-simulation as shown in the screenshot
below.

Figure 3-8: Result Window.

On opening, the satellite log file would look like the image below.
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Figure 3-9: NetSim Satellite communication log file.

This file logs details such as

� UT – Satellite Gateway association
� Calculated Super frame, frame, slot, bandwidth, carrier count etc. for each satellite.
� Frame by frame transmissions with time stamps

3.9.2 Satellite Radio Measurements Log

NetSim Satellite Radio Measurements Log file records Time (ms), Transmitter name, Receiver name, Slant
height (km), EIRP (dBW), Elevation Angle (◦), RXG T, Pathloss (dB), Fading loss (dB), Additional loss
(dB), Total loss (dB), Angular gain (dB), Rx power (dBm), SNR (dB), Thermal noise (dBm), Channel
Id, Beam Id, MCS Index and Coding rate. This log can be enabled/disabled by going to Logs option and
checking/unchecking the Satellite Radio Measurements Log option under the Network Logs section as
shown below:

Figure 3-10: Enabling Satellite Radio Measurements Log file.
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The Satellite Radio Measurements.csv file will contain the following information:

� Time in Milliseconds
� Transmitter Name
� Receiver Name
� Slant height (km)
� EIRP (dBW)
� Elevation Angle (◦)
� RXG T
� Pathloss (dB)
� Fading loss (dB)
� Additional loss (dB)
� Total loss (dB)
� Angular gain (dB)
� Rx power (dBm)
� SNR (dB)
� Interference (dBm)
� Thermal noise (dBm)
� Channel Id
� Beam Id
� MCS Index and
� Coding rate

Satellite Radio Measurements log files will be available under the Logs in the results window as shown
below:

Figure 3-11: Result Window.

Users can see Tx Power, Rx power, pathloss, fading-loss, Total loss, Thermal noise, and SNR values in
the Log files for each forward and return link.

Figure 3-12: Satellite Radio Measurements log file.

3.9.3 Satellite Beam Association Log

The NetSim Satellite Beam Association Log file is useful for observing the values recorded for each
beam, including Time (ms), TX Name, RX Name, EIRP (dBW), Beam Id, Channel Id, Theta (◦),
Angular Gain, RXG T (dB), FSPL (dB), Total loss (dB), SNR (dB), Interference (dBm), Interfering
Beam Count, MCS Index, and Coding rate. This log can be enabled/disabled by going to Logs option
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and checking/unchecking the Satellite Beam Association Log option under the Network Logs section as
shown below:

Figure 3-13: Results window.

Users can see Angular Gain, Interference and SNR values in the Log files for each forward and return
link. These parameters are logged separately for each beam.

Figure 3-14: Satellite Beam Association log file.

3.10 Omitted Features

� Regenerative transponder where the signal is demodulated, decoded, re-encoded and modulated
aboard the satellite.

� Impact of Rain/Weather on signal propagation
� Forward Error Coding in Layer 2
� IPv6 Addressing
� No support for LEO, MEO

4 Featured Examples

4.1 India region coverage with 16-Beam GEO Satellite with frequency reuse

Open NetSim, Select Examples → Satellite Communication → India region coverage with 16-Beam GEO
Satellite with frequency reuse then click on the tile in the middle panel to load the example as shown
below.
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Figure 4-1: List of scenarios for the example of India region coverage with 16-Beam GEO Satellite with
frequency reuse.

This example models a GEO satellite at 35,768 km altitude providing coverage over the mainland Indian
region (North-East, Andaman & Nicobar & Lakshadweep will be covered in our next iteration) using 16
spot beams. Each beam spans a 1◦ beamwidth (≈312 km radius) and serves 100 randomly placed user
terminals, for a total of 1600 UTs across the coverage area. The scenario uses the DVB-S2 protocol with
ITU-R S.672-4 antenna patterns. Two frequency reuse configurations are compared: FR2 (250 MHz per
beam) and FR4 (125 MHz per beam). FR2 offers higher per-beam bandwidth but increased inter-beam
interference; FR4 reduces interference at the cost of bandwidth per beam.

Figure 4-2: India covered using 16 spot beams. Each beam spans a 1◦ beamwidth (≈312 km radius) and
serves 100 randomly placed user terminals (UTs), for a total of 1600 UTs across the coverage area. Beam
centres are red dots while UTs are green dots.

The objective is to evaluate the trade-off between these configurations by measuring SINR and throughput
distributions, satellite capacity, and spectral efficiency.
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4.1.1 Network Scenario

The following network diagram illustrates what the NetSim UI displays when you open the example
configuration file. When the example configuration file is opened, NetSim would take some time to load
this large scenario. During this time, the UI displays progress information such as the number of devices
and applications being loaded.

Figure 4-3: Network set up for studying the GEO Satellite, 16 Spot Beams on Indian Region, ITU S.672
Antenna.

Orbit

� GEO satellite at 35768 km altitude.

Protocol and Beams

� DVB-S2
� 16 spot beams covering the Indian region.
� Randomly placed 100 UTs in each beam (total of 1600UTs).
� Frequency reuse options: 2 and 4

Antenna

� Pattern: ITU S.672-4
� EIRP: 54 dBW

Traffic

� Unicast downlink traffic to each UT

Objective

� Measure the distributions and percentiles of SINR and throughput
� Obtain satellite capacity and spectral efficiency
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4.1.2 Simulation Setup in NetSim

� The satellite is positioned at 82◦E, 0◦ latitude in GEO orbit.
� Remote Server, Router, and Gateway are logical constructs for enabling traffic flow; their positions

are not physical.

Table 4-1: Simulation settings.

System Model

Satellite orbit GEO 35678 km

EIRP (dBW) 54

Frequency Reuse FR2, FR4

Frequency Band 11 GHz

Bandwidth (MHz) 250 MHz for each FR2 beam / 125 MHz for each FR4 beam

Traffic Unicast traffic to each UT

Antenna pattern ITU-R S.672-4

Protocol DVB-S2

UT Height (m) 1.2

UT RX Antenna Gain (dB) 40

Number of beams 16

Beam width 1◦

MCS selection Adaptive MCS

UT Density 100 UTs per beam

Frame size (bits) 64,800

� Simulation time is set to 10 seconds.
� Application is configured from the Wired node to each UT with the generation rate set to 5 Mbps

per application.

4.1.3 Beam Positions and Frequency Coloring

Table 4-2: Beam Positions.

Beam ID Longitude Latitude

1 82.50 22.50

2 79.94 18.27

3 85.06 18.27

4 77.24 22.41

5 87.76 22.41

6 79.78 26.68

7 85.22 26.68

8 82.50 14.08

9 74.82 18.14

10 80.04 9.84

11 82.50 30.92

12 74.35 26.48

13 90.65 26.48

14 77.49 14.03

15 95.53 22.41

16 76.84 30.80
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Figure 4-4: Frequency Coloring.

Rbeam = h× tan

(
θ

2

)
, h = 35,768 km, θ = 1◦ (34)

Rbeam = 312 km, InterBeamDist =
√
3 ·Rbeam = 540.57 km (35)

4.1.4 Results Summary

Results: FR2

Table 4-3: FR2 Results summary.

5% 50% 95%

SINR (dB) −0.55 4.91 8.85

UE Thput. (Mbps) 1.49 3.22 4.87

Beam Thput. (Mbps) 223.74 317.61 480.91

Capacity and Efficiency Metrics (FR2):
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Satellite capacity = 5199.75 Mbps

Area Traffic capacity:

Number of beams = 16

Beam radius, R = 312.3 km

Area per beam (A) = 3
√
3

2 R2 = 253424.62 km2

Total coverage area = 253424.62 km2 × 16 = 4054793.9 km2

� Area Traffic Capacity = 1.28 kbps/km
2

Average Spectral efficiency (FR2)

System Bandwidth = 500 MHz

Spectral Efficiency

ηsystem =
Aggregate Throughput (bps)

System Bandwidth (Hz)
=

5199.75× 106

500× 106
= 10.39 bits/s/Hz (36)

Results: FR4

Table 4-4: FR4 Results summary.

5% 50% 95%

SINR (dB) 1.79 9.42 12.25

UE Thput. (Mbps) 0.80 2.42 4.86

Beam Thput. (Mbps) 144.37 236.04 388.62

Capacity and Efficiency Metrics (FR4):

Satellite capacity = 4230.56 Mbps

Area Traffic capacity:

Number of beams = 16

Copyright TETCOS LLP Page 38 of 46



NetSim – Satellite Communication Ver 15.0

Beam radius, R = 312.3 km

Area per beam (A) = 3
√
3

2 R2 = 253424.62 km2

Total coverage area = 253424.62 km2 × 16 = 4054793.92 km2

Area Traffic Capacity = 1.04 kbps/km
2

Average Spectral efficiency (FR4)

System Bandwidth = 500 MHz

ηsystem =
Aggregate Throughput (bps)

System Bandwidth (Hz)
=

4230.56× 106

500× 106
= 8.46 bits/s/Hz (37)

4.1.5 5th, 50th, 95th percentile UTs

(FR 2 case) 5th percentile 50th percentile 95th percentile

Received Signal (dBm) −80.84 −80.80 −80.26

CNR (dB) or C/N 9.15 9.19 9.72

Interference Power (dBm) −80.78 −87.74 −96.51

CIR (dB) or C/I −0.07 6.95 16.25

CINR (dB) or C/(N+I) −0.55 4.91 8.85

Throughput (Mbps) 1.49 3.22 4.87

� The 5% UT is located at the beam edge and subject to interference from other beams.
� The 95% UT is near the beam center with very low interference from other beams.

To plot the CDF of SINR per UT and per beam, we considered the metrics.xml file and the Radio
Measurements log file.

4.2 Bandwidth variation through MCS configuration

Open NetSim, Select Examples → Satellite Communication → Bandwidth variation through MCS
configuration then click on the tile in the middle panel to load the example as shown below.

Figure 4-5: List of scenarios for the example of Bandwidth variation through MCS configuration.
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The following network diagram illustrates what the NetSim UI displays when you open the example
configuration file.

Figure 4-6: Network set up for studying the Bandwidth variation through MCS configuration.

Settings done in example config file:

1. Set the following property as shown in the table below. To configure it, click on the satellite device,
expand the property panel on the right side, and change the property as below.

Table 4-5: Satellite Properties → Interface (Satellite) → Physical Layer → Forward.

Satellite Properties → Interface (Satellite) → Physical Layer → Forward

BER Model Fixed

BER 0.00000001

2. Click on UT Router and set the following property as shown in below given table.

Table 4-6: UT Router Properties → Interface (Satellite) → Datalink Layer.

UT Router Properties → Interface (Satellite) → Datalink Layer

Gateway Sat Gateway 2

NOTE: For manually configured scenario, the user needs to mention the gateway name for UT nodes
under datalink layer.

3. Go to Router 4 properties → Network Layer → Enable – Static IP Route → Click on Static Route
IP via GUI.
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Figure 4-7: Router Network layer properties window.

4. Set the properties in Static Route IP window as per the screenshot below and click on Add. Click
on OK.

Figure 4-8: Configuring Static route window for router.

5. Go to Sat Gateway 2 properties → Network Layer → Enable – Static IP Route → Configure Static
Route IP via GUI. Set the properties in Static Route IP window as per the screenshot below and
click on Add. Click on OK.
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Figure 4-9: Configuring Static route window for Sat Gateway 3.

6. Go to UT Router 3 properties → Network Layer → Enable – Static IP Route → Configure Static
Route IP via GUI. Set the properties in Static Route IP window as per the screenshot below and
click on Add. Click on OK.

Figure 4-10: Configuring Static route window for UT Router 2.

7. Create a CBR application from set traffic tab in ribbon on the top between source id 5 to destination
id 6 with packet size as 1460 Bytes and Inter Arrival time as 467 µs (Generation Rate = 25 Mbps).
Transport Protocol is set to UDP.

8. Change the Satellite Properties → Interface (Satellite) → Physical Layer → Forward → Modulation
and respective coding rates as shown in below Table but the return link uses fixed Modulation →
32APSK and Coding Rate → 3/4.

9. Run simulation for 10 seconds and observe the result.

NOTE: Satellite physical layer changes are done only for the forward and return layer properties.

Result: Observe the application throughput as we change the modulation scheme (Satellite Properties →
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Interface (Satellite) → Physical Layer → Forward → Modulation) and respective coding rates (Satellite
Properties → Interface (Satellite) → Physical Layer → Forward → Coding Rate).

Table 4-7: Compare the different Modulation Scheme and Coding Rate vs. Throughput.

Modulation Coding Rate Throughput (Mbps)

QPSK
1/3 0.087

9/10 0.355

8PSK
3/5 0.399

9/10 0.532

16APSK
2/3 0.534

9/10 0.713

16QAM
3/4 0.712

5/6 0.713

32APSK
3/4 0.891

8/9 0.892

4.3 Configuring applications from UT Node to UT Node

Open NetSim, Select Examples → Satellite Communication → UT to UT Communication then click on
the tile in the middle panel to load the example as shown in the screenshot below.

Figure 4-11: List of scenarios for the example of UT to UT Communication.

The following network diagram illustrates what the NetSim UI displays when you open the example
configuration file.
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Figure 4-12: Network set up for studying the UT-to-UT Communication.

Settings done in example config file

� Click on UT node and expand the property panel on the right side and set the following property
as shown in the table below:

Table 4-8: UT Node Properties → Interface (Satellite) → DataLink Layer.

UT Node Properties → Interface (Satellite) → DataLink Layer

Gateway Sat Gateway 2

� Similarly, go to UT Node 3 properties → Network Layer → Enable – Static IP Route → Configure
Static Route IP.

Figure 4-13: Network layer properties window for UT Node 3.

1. Set the properties in Static Route IP window as per the screenshot below and click on Add. Click
on OK.
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Figure 4-14: Configure static route for UT Node 3.

2. Go to Sat Gateway 2 properties → Network Layer → Enable – Static IP Route → Configure Static
Route IP via GUI.

Figure 4-15: Network layer properties window for Sat Gateway 2.

3. Set the properties in Static Route IP window as per the screenshot below and click on Add. Click
on OK.
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Figure 4-16: Configure static route for Satellite Gateway 2.

4. Create application from set traffic tab in the ribbon on the top and set application properties as
default (Packet Size: 1460, Inter Arrival Time: 20000 µs)

5. Click on application and set Transport Protocol to UDP in property panel.
6. Set the Link model to Abstract Link under Physical layer of satellite device.
7. Enable Packet Trace and Plots from the configure report tab.
8. Run simulation for 100 seconds and observe the result.

Result: Go to the result window and open packet trace, filter the PACKET ID to 1. There, the user
can observe the packet flow from UT node (source) → Satellite → Sat gateway → Satellite → UT node
(destination)

Figure 4-17: Packet Trace.
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